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Лабораторная работа № 1, №2 Тема: «Конструирование геометрических 

элементов улично-дорожной сети» 

Приступая к созданию модели функционирования в программе AIMSUN, 

необходимо запустить приложение и выполнить команду File → New. В 

появившемся диалоговом окне выбрать шаблон (рис. 1), представляющий собой 

обычный файл сети AIMSUN и потому, с формальной точки зрения, 

содержащий в своем составе объекты любого допустимого типа. Но, как 

правило, шаблоны применяются для:  

• выбора единиц измерения (метрических или англо-

американских) и типа движения (правостороннего или 

левостороннего);  

• предварительного создания некоторых объектов  

o типов и классов транспортных средств,  

o типов полос,  

o стилей и режимов отображения  

 
Рисунок 1- Диалоговое окно выбора шаблона сети 

Для удобства конструирования геометрии улично-дорожной сети 

используют растровые изображения и векторные чертежи САПР в качестве 

фона. В настоящий момент система поддерживает следующие графические 

форматы:  

•векторные — DXF, DWG и DGN (САПР) и Shapefiles (ГИС);  

•растровые с ручной привязкой к местности — JPEG, GIF, PNG, 

BMP;  

•растровые с автоматической привязкой к местности — JPEG 2000, 

ECW, MrSID.  

Процесс импорта начинается с вызова команды меню File→Import. Затем 

следует выбрать формат импортируемого файла (рис. 2) и, используя 

стандартное окно навигации, указать требуемый файл. В следующем 

диалоговом окне запрашивается дополнительная информация, зависящая от 

выбранного формата. 
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 Рисунок 2- Диалоговое окно импортирования подложки 

Файл САПР импортируется на одноименный слой, а каждый слой файла 

САПР импортируется как подслой. Объекты файла не могут переноситься или 

масштабироваться, однако, предусматривается возможность скрытия 

отдельных слоев и отображения их содержимого в AIMSUN. Отдельные 

объекты в файле САПР нельзя ни редактировать, ни даже выбирать.  

Файлы с данными геоинформационных систем, как и их аналоги формата 

САПР, размещаются на отдельных слоях. Объект импортированного файла 

ГИС, в отличие от файла САПР, поддается выбору (двойным щелчком), после 

чего открывается окно с неграфической информацией, описывающей объект. 

Каждое импортированное растровое изображение размещается на слое как 

графический объект — подслой слоя Images. Объект можно выбирать, 

переносить и масштабировать.  

По завершению редактирования растрового изображения, слой полезно 

блокировать, чтобы исключить возможность его случайного изменения или 

сдвига. Для этого необходимо дважды щелкнуть на слое Images в списке слоев 

и сбросить флажок с Allow Object Editing. 

Геометрическая структура улично-дорожной сети представлена набором 

соединенных в пересечения и/или примыкания секций. Геометрия секции 

задается набором точек, определяющих местоположение и ориентацию прямо- 

и криволинейных сегментов. Каждой точкой можно манипулировать отдельно. 

Для того, чтобы создать секцию необходимо щелкнуть на Create Section 

( ) на панели инструментов. Затем, указать щелчком левой кнопки мыши на 

виде позицию точки начала секции, а затем, двойным щелчком, точку ее 

завершения. Положение секции можно изменить путем перетаскивания 

опорных точек ее осевой линии, которые оказываются видимыми при выборе 

секции. Секции можно придать форму, для этого используют кнопки New 

(Straight  или Curve ) панели инструментов. Первая служит для 

определения прямолинейных, а вторая — криволинейных сегментов. В секцию 

может быть включено произвольное число вершин. Между двумя такими 

вершинами можно добавить до двух новых контрольных точек. Чтобы создать 

вершину, следует выбрать секцию, щелкнуть на соответствующей из названных 
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кнопок, щелчком левой кнопки мыши указать точку на виде и, не отпуская 

кнопку, построить вспомогательный отрезок так, чтобы он пересекал секцию в 

том месте, где требуется вершина или контрольная точка. Эту точку можно 

перемещать, изменяя форму секции надлежащим образом (рис.3). 

 
Рисунок 3- Графическая правка секции 

Для увеличения/уменьшения числа полос следует выбрать секцию, 

щелчком правой кнопки мыши открыть контекстное меню и вызвать 

подходящую команду подменю Number of Lanes. Альтернативный способ 

выполнения операции связан с выбором секции и последующим вводом числа 

полос при нажатой клавише <Ctrl>. Чтобы создать или удалить боковую полосу 

(или обочину), следует воспользоваться подходящей управляющей точкой, 

расположенной вблизи начала/конца секции (рис.4). 

 
 

 Рисунок 4= Добавление и удаление боковых полос 

В контекстном меню секции есть еще одна полезная опция — она связана с 

созданием параллельной секции, ориентированной в противоположном 

направлении: достаточно выбрать секцию, щелчком правой кнопки мыши 

открыть контекстное меню и вызвать команду generate opposite direction.  

Для соединения секций следует выбрать их (при нажатой клавише 

<Shift>), щелчком правой кнопки мыши на любой из выбранных секций 

открыть контекстное меню и выбрать команду Join (или нажать комбинацию 

клавиш <Ctrl+M>) (рис.5). 
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Рисунок 5-Соединение секций 

Пересечения в одном уровне и примыкания автомобильных дорог 

создаются с помощью кнопки Create Node , которая вызывает диалоговое 

окно редактора узла. Для определения каждого поворота необходимо щелкнуть 

на кнопке New на вкладке Main, щелчком левой кнопки мыши указать на 

графическом виде полосу исходной секции (для одновременного выбора 

нескольких полос следует удерживать нажатой клавишу <Shift>), а затем 

полосы целевой секции (рис.6). 

 

   
Рисунок 6- Варианты создания узлов 

Для определения приоритетных направлений движения, самым 

эффективным является способ включения ограничения Уступи дорогу для 

различных поворотов, состоящий в выборе узла с последующим указанием всех 

поворотов, подлежащих ограничению, и вызове контекстного меню с выбором 

команды Warning → Give Way . Можно также задать приоритет движения, 

обратившись к редактору узла и выбрав опцию Give Way в столбце Warning для 

рассматриваемого поворота (рис.7). 

Для повышения степени реалистичности модели движения повороты на 

перекрестке можно сделать более плавными. Для этого линии поворотов 
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следует снабдить вершинами Curve . К тому же, возможна модификация 

точек перекрестка, на которых должен останавливаться транспорт для 

предоставления приоритета движения не только на общей стоп - линии, но и 

несколькими метрами дальше.  

 

 

 
Рисунок 7-Варианты установления приоритетных направлений движения в 

узле 

При редактировании секций определяют следующие группы атрибутов в 

окне редактора секций или посредством вызова контекстного меню: 

•идентификаторы — наименование и внешний идентификатор;  

•общая информация — тип дороги, значения скоростей и пропускная 

способность;  

•физические характеристики — исходная и конечная высота;  

•планируемые данные — значения затрат, определяемых 

пользователем, дополнительная нагрузка и функция задержки;  

•сведения о полосах (рис.8). 
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Рисунок 8- Определение типа дороги и назначение скоростей текущей 

секции 

 

Лабораторная работа № 3-4 Тема: «Расчет матрицы корреспонденций 

внутреннего легкового транспорта» 

Распределение интенсивности дорожного движения по секциям модели 

может осуществляться посредством O/D Matrix или Traffic State. 

O/D Matrix содержит значения интенсивности дорожного движения по 

типам транспортных средств между центроидами, являющимися пунктами 

генерирования транспортных средств, их отправки и прибытия, в течение 

заданного периода времени. Матрица определяет также набор допустимых 

маршрутов движения между центроидами. 
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Если исходные данные по интенсивности дорожного движения вводятся в 

проект через  O/D Matrix, то, сначала, необходимо определить центроиды, 

которым соответствует матрица. Чтобы пополнить сеть центроидом, нужно 

щелкнуть на кнопке Create centroid ( ) панели инструментов, а затем в том 

месте, где его следует расположить. После создания центроида, двойным 

щелчком на нем открыть окно редактора и на вкладке Main задать 

рекомендованное наименование. Далее необходимо определить прямые и 

обратные связи центроида с сетью. Для этого следует щелкнуть на кнопке New 

и выбрать секцию въезда или выезда. По завершении работы щелкнуть на 

кнопке OK (рис.9). 

 
Рисунок 9- Определение прямых и обратных связей центроида 

Матрицу создают, обратившись к папке Centroids Configurations в окне 

Project. Необходимо щелкнуть правой кнопкой мыши на ветви, 

представляющей требуемую конфигурацию центроидов, и выбирать в 

контекстном меню команду New... → O/D Matrix. Затем двойным щелчком 

открыть окно редактора и определить объем движения транспортных средств 

по сети из одного центроида в другой, назначить тип транспортного средства, 

начальное время действия данной матрицы в модели на вкладке Main (рис.10). 

Здесь же, посредством применения математических функций, можно провести 

статистические операции по изменению значений, представленных в матрице 

(рис.11-12). 
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Рисунок 10- Определение объема движения транспортных средств по сети 

в O/D матрице 

 
 

Рисунок 11- Применение функции Join с суммированием объемов 

движения и длительности действия матриц и Sum с суммированием только 

объемов движения 

  
Рисунок 12- Применение функции Split для разделения по типам 

транспортных средств c исходным периодом действия матрицы и Split duration 

с разделением периода действия матрицы для двух новых 

 

Созданные O/D Matrix или Traffic State указываются в Traffic demand. Для 

этого следует дважды вызвать команду меню Project → New → Demand Data → 

Traffic Demand. В окне редактора указать тип структуры привлекаемых данных 

(O/D Matrix или Traffic State), далее, щелкнув по кнопке Add Demand Item, 

выбрать из списка всех имеющихся созданные ранее O/D Matrix или Traffic 

State. После выбора элемента, тот включается в диаграмму Гантта, 

расположенную в средней части окна редактора. Элемент диаграммы можно 

выбрать щелчком (результат обозначается красным цветом), после чего 

масштабировать и/или переместить в требуемый временной интервал (рис.15). 
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Рисунок 13- Отображение всей необходимой информации по 

интенсивности дорожного движения для работы с Traffic State 

 

  
Рисунок 14- Формирование исходных данных по интенсивности 

дорожного движения в Traffic State 
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Рисунок 15- Создание Traffic Demand 

 

Лабораторная работа № 5 Тема: «Определение уровня загрузки 

городской улично-дорожной сети» 

Уровень (коэффициент) загрузки движением - отношение фактической 

интенсивности движения по автомобильной дороге, приведенной к легкому 

автомобилю, к пропускной способности за заданный промежуток времени. 

Пропускная способность - максимальное число автомобилей, которое 

может пропустить участок дороги в единицу времени в одном или двух 

направлениях в рассматриваемых дорожных и погодно-климатических 

условиях. 

Практическая (фактическая) пропускная способность - пропускная 

способность участка дороги в реальных условиях движения. 

Уровень обслуживания - комплексный показатель экономичности, 

удобства и безопасности движения, характеризующий состояние транспортного 

потока. 

Значения уровня обслуживания прилегающих участков улично-дорожной сети 

в границах объекта проектирования определялись в соответствие с ОДМ 

218.2.020-2012. 

P

N
Z = ,  (1) 

где N  - интенсивность движения, авт/ч; P - практическая пропускная 

способность участка дороги. 
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Таблица 1 - Характеристика уровней обслуживания движения 

Уровен

ь обслу

живани

я 

движен

ия 

Коэффи

циент 

загрузки 

z 

Характеристика 

потока 

автомобилей 

Состояние 

потока 

Эмоциональн

ая загрузка 

водителя 

Удобство 

работы 

водителя 

Экономическая 

эффективность 

работы дороги 

А < 0,20 Автомобили 

движутся в 

свободных 

условиях, 

взаимодействие 

между 

автомобилями 

отсутствует 

Свободное 

движение 

одиночных 

автомобилей с 

большой 

скоростью 

Низкая Удобно Неэффективная 

В 0,20 - 

0,45 

Автомобили 

движутся 

группами, 

совершается много 

обгонов 

Движение 

автомобилей 

малыми 

группами (2 - 5 

шт.). 

Обгоны 

возможны 

Нормальная Мало 

удобно 

Мало 

эффективная 

С 0,45 - 

0,70 

В потоке еще 

существуют 

большие 

интервалы между 

автомобилями, 

обгоны запрещены 

Движение 

автомобилей 

большими 

группами (5 - 

14 шт.). 

Обгоны 

затруднены 

Высокая Неудобно Эффективная 

D 0,70 - 

0,90 

Сплошной поток 

автомобилей, 

движущихся с 

малыми 

скоростями 

Колонное 

движение 

автомобилей с 

малой 

скоростью.Обг

оны 

невозможны 

Очень 

высокая 

Очень 

неудобно 

Неэффективная 

Е 0,90 - 

1,00 

Поток движется с 

остановками, 

возникают заторы, 

режим пропускной 

способности 

Плотное Очень 

высокая 

Очень 

неудобно 

Неэффективная 

F > 1,00 Полная остановка 

движения, заторы 

Сверх плотное Крайне 

высокая 

Крайне 

неудобно 

Неэффективная 

Примечание-К участкам автомобильной дороги, обслуживающей движение в режиме 

перегрузки, относятся участки автомобильной дороги с уровнем обслуживания D, Е или Е 

Для построения схему уровней загрузки необходимо промоделировать весь 

изучаемый период времени. Затем в окне видовых фильтров выбрать указать 

Simulated V/C (Colour). Пример схемы уровней загрузки представлен на 

рисунке 16. 
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Рисунок 16 – Схема уровней загрузки в модели городской улично-

дорожной сети 

Лабораторная работа № 6 Тема: «График-изохрона транспортной 

доступности» 

Очень удобным и наглядным способом характеристики и оценки степени 

совершенства геометрических схем УДС является построение графиков-

изохрон, отражающих степень влияния вида геометрической схемы на время и 

скорость передвижения по сети. Согласно основным нормативным 

градостроительным документам, максимальное время движения при поездках 

по трудовым целям не должно превышать 32 минуты для городов с населением 

до 250 000 человек.  

Для характеристики транспортной доступности микрорайонов города 

выполнены исследования с использованием современного программного 

обеспечения, полученные результаты интегрированы и построен график-

изохрона, который обозначает зоны соответствующей временной доступности.  

Для этого следует вызвать команду меню Data Analysis → Isochrones. В 

окне редактора указать:  

• целевой объект, кликнув указателем мыши по нему в рабочей 

области; 

• назначить ему тип расчёта (прибытие/отправление); 

• выбрать критерий расчёта; 

• назначить число интервалов распределения значений изохроны; 

• цветовую шкалу.  

Пример полученной изохроны представлен на рисунке 17. 
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Рисунок 17 – График-изохрона в модели городской улично-дорожной сети 

 

Лабораторная работа № 7 Тема: «Общесетевые характеристики 

функционирования УДС» 

Для определения параметров эффективности функционирования модели 

дорожного движения используют статистические данные, получаемые в ходе 

проведения эксперимента. Как правило, эти данные представляются в виде 

графиков изменения значений переменных (скорость транспортного потока, 

задержки транспортных средств, количество остановок транспортных средств и 

т.д.) в течение всего периода моделирования c определенным интервалом. 

Причем, представляется возможным просмотреть полученные результаты как 

для всей модели функционирования улично-дорожной сети, так и для каждой 

ее отдельной секции.  

Для определения интервала детектирования значений переменных 

необходимо двойным щелчком мыши открыть окно редактора сценария 

моделирования и перейти на вкладку Output , где отметить в строках Detection и 

Statistics позиции Activate и Keep in memory для просмотра результатов 

моделирования, позицию Store – для сохранения результатов в имеющейся базе 
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данных Access, и указать интервал детектирования и сохранения результатов 

(рис.18). 

 
Рисунок 18 - Окно редактора вывода результатов моделирования 

После проведения эксперимента по моделированию дорожного движения в 

окне редактора объекта (секции, детектора, Replication) появляется вкладка 

Time Series c графическим представлением изменения значений переменных 

либо в формате таблицы числовых значений (до десяти рядов данных). Для 

добавления/удаления рядов используются одноименные команды контекстного 

меню кнопки Action, а для выбора — раскрывающиеся списки в верхней части 

вкладки. Из второго и последующих списков можно выбирать только 

совместимые ряды, т.е. представляющие одну и ту же переменную (скорость, 

плотность потока, время задержки, количество остановок и пр.) и содержащие 

данные, которые относятся к тому же временному периоду.  

Опция Use Date применяется в том случае, если ряды должны 

сопоставляться с учетом даты, т.е. одновременно позволяется выводить данные 

тех рядов, дата и время которых совпадают. Если флажок сброшен, проверяется 

совпадение только времени рядов.  

При использовании графического представления пределы диаграммы 

можно настраивать с помощью команд подменю Adjust limits контекстного 

меню кнопки Action, принимая во внимание значения текущего объекта либо 

всех объектов. (Применяется в том случае, если сравнению подлежат несколько 

объектов, поскольку разные диаграммы будут представлены в одном 

масштабе).  

При установке флажка Deviation значения рядов данных, состоящих из 

средних значений, дополняются величиной отклонения, которое отображается в 

таблице вслед за значением в скобках (рис.28).  
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Рисунок 19- Представление результатов моделирования в графическом и 

табличном видах 

Для оценки эффективности дорожного движения на маршрутах, 

транспортных коридорах и сетях улиц и дорог, используется ряд комплексных 

сетевых показателей, характеризующих скорость и надежность сообщения 

автомобильным транспортом: 

• Средневзвешенный сетевой уровень обслуживания - характеризует 

сетевой уровень качества ОДД, взвешенный по объемам движения на 

элементах улично-дорожной сети;  

• Сетевой показатель мобильности – характеризует средний взвешенный 

темп движения на множестве обследуемых маршрутов; 

• Средняя сетевая скорость – характеризует скорость движения 

транспортных потоков, взвешенную по объемам движения на элементах 

улично-дорожной сети; 

• Сетевой показатель загруженности–характеризует среднюю взвешенную 

долю времени существования заторовых ситуаций на обследуемых объектах 

транспортной инфраструктуры;  

• Временные показатели (временной индекс, временной буфер, буферный 

индекс) - характеризуют надежность транспортной системы в условиях 

меняющейся загрузки транспортной сети; 

• Критерий Германа-Пригожина – характеризует степень 

«чувствительности» объекта дорожной инфраструктуры к возрастанию 

загруженности сети движением 
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